
MENUS

The menus in robotSim control many different aspects of the program.   
The menus available in robotSim are listed as follows. 

File

The File menu contains menu items that allow you to manage the creation, saving, 
and opening of your projects.  There are also menu items that let you adjust the 
preferences for robotSim, and quit the robotSim application.

New
The “New” menu item creates a new robotSim project.  You can choose between 
an empty project, or one of the available environments to start with.  Be sure to 
save your current project before creating a new one.
Open
The “Open” menu item allows you to open an existing project.  Be sure to save any 
changes to the current project before opening a different one.
Save
The “Save” menu item allows you to save the current project.  It will save the 
project as the same name, or prompt you to choose a name if it is your first time 
saving that project.
Save As
The “Save As” menu item allows you to choose the name of the save file to save 
your project in.
Preferences
The “Preferences” menu item opens the Preferences dialog where you can change 
the robotSim settings.
Exit
The “Exit” menu item will close robotSim.  This is equivalent to clicking the red ‘X’ 
to close the application.  Be sure to save your project before exiting.

Using robotSim

This is a general guide to using robotSim.  This section includes help on the 
different menus in robot sim, toolbars, and windows that you will interact with.
This section is divided into the following subsections:
Menus
Toolbars
Windows



Edit

The Edit menu contains menu items that allow you to undo and redo the last 
actions performed, as well as cut, copy, paste, and delete objects.

Undo
The “Undo” menu item reverses the last change made to the project.

Redo
The “Redo” menu item will apply the command that was last reversed using the 
“Undo” command.

Cut
The “Cut” menu item removes the selected object from the simulator.  The last object 
cut (or copied) can then be added back to the sim using the “Paste” command.

Copy
The “Copy” menu item makes a copy of the selected object without changing or 
removing the selected object.  The last object copied (or cut) can then be added to 
the sim using the “Paste” command.

Paste
The “Paste” menu item adds the last object that was cut or copied from the 
simulator.  If no object is on the clipboard (cut or copied) nothing will be pasted.

Delete
The “Delete” menu item deletes the selected object from the simulator.

View

The View menu is where the view settings for the toolbars and various windows 
are changed.  To show or hide one of these windows or the toolbars, simply select 
the menu item corresponding to it.

Toolbars
The “Toolbars” menu item allows you to show or hide the toolbars.  When the 
Toolbars item has a check beside it the toolbars are shown. When the Toolbars 
item is not checked the toolbars are hidden.

Status Bar
The “Status Bar” menu item allows you to show or hide the status bar. When the 
Status Bar item has a check beside it the status bar is shown. When the Status Bar 
item is not checked the status bar is hidden.

 Objects
The “Objects” menu item toggles between showing 
and hiding the Objects window.  The Objects window is 
covered in more detail in the “Objects Window” section of 
this manual. 
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View

Explorer
The “Explorer” menu item toggles 
between showing and hiding the 
Explorer window.  The Explorer 
window is covered in more detail 
in the “Explorer Window” section 
of this manual.

Robots
The “Robots” menu item toggles 
between showing and hiding 
the Robots window.  The Robots 
window is covered in more detail 
in the “Robots Window” section of 
this manual.

 

Properties
The “Properties” menu item 
toggles between showing and 
hiding the Properties window.  
The Properties window is covered 
in more detail in the “Properties 
Window” section of this manual.

Project

The Project menu is where the settings for the current project can be changed.  
You can also add lights to the current project using the “Add Light” submenu.  

Add Light
The “Add Light” menu item opens up a submenu containing the various lights that 
can be added to the current project.

The “Directional” submenu item adds a Directional Light to the current project. 
Directional Lights are considered infinitely far away and affect everything in the scene.

The “Point” submenu item adds a Point Light to the current project. 
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Project 

Point Lights emit light equally in all directions up to objects within their range.
The “Spot” submenu item adds a Spot Light to the current project. Spot Lights 
emit light within a cone. 

Settings

The “Settings” menu item opens up the settings dialog for the current project.

Gravity   
Sets the acceleration of gravity in the simulator in the X, Y, and Z directions.

Solver Count  
Sets the accuracy of the simulator’s physics.  A higher solver count will give more 
accurate physics, but lower performance.

Time Scale
Sets the rate that time passes in the simulator.  For example, a time scale of 2.0 
would move at double the speed of real time, and a time scale of 0.5 would move 
at half the speed of real time.

Tick Rate
Sets the frequency per second that the simulator’s physics are updated.  A higher 
tick rate will give smoother, more accurate physics, but lower performance.



Render

The Render menu is where you can change how the selected item in your project is 
drawn to the screen.  Aside from “Camera Light” all rendering options are only applied 
to the currently selected object.  Most rendering options are only useful for debugging 
purposes, so it is recommended to keep them off to maintain performance.

Wireframe
The “Wireframe” menu item toggles between 
showing and hiding the wireframe model of the 
selected object.

Physics
The “Physics” menu item toggles between 

showing and hiding the physics collider of the 
selected object.  The physics collider is the 

physics object that will causes collisions.  More 
information on colliders can be found in the 

Properties Window Collider section.
 

Bounding Box
The “Bounding Box” menu item toggles 
between showing and hiding the bounding 
box of the selected object.  The bounding 
box is the area that the can be clicked in to 
select an object.
 

Camera Light
The “Camera Light” menu item toggles between turning on and turning off the 
camera light.  The default is to turn the camera light on, so that the objects can be 
seen properly.  Turning off the camera light will make the objects dark, unless you 
have added an additional light source. In the first image the camera light is off, 
making it hard to see the objects. In the second image the camera light is on (as it 
is by default), so the objects are much easier to see.



Run

The Run menu is where the controls to start, pause, or stop the simulator are 
located.  These controls can also be accessed from the toolbar.  

Start / Pause
The “Start” menu item starts the simulator.  Physics calculations are performed, 
and robots can be controlled.  While the simulator is running, the “Start” menu 
item will become the “Pause” menu item, which pauses the simulator.  Choosing 
“Start” while the simulator is paused will allow the simulator to continue running.  
The state the simulator is in is saved when it is started, and once stopped, 
the reset action will reset the simulator to that state.  Choosing “Start” always 
overwrites the reset state.

Stop
The “Stop” menu item stops the simulator until it is started again.  Once the 
simulator is stopped, the reset button will reset the simulator to the state it was in 
before it was started.

Reset
The “Reset” menu item will reset the simulator to the state it was in before it was 
started.  Any objects added to the simulator while it is running will be reset to the 
state they were in when they were first added.

Help

The Help menu is where you can access assistance such as this user manual. 

Activation
The “Activate” menu item launches the robotSim activation program.  You can use 
the activation program to activate or deactivate robotSim and its modules.

Documentation
The “Documentation” menu item opens this user manual in your default browser.

About
The “About” menu item displays information about robotSim and Cogmation 
Robotics.



TOOLBARS
  

The toolbars in robotSim control many differenent aspects of the program.

File Management

 The file management toolbar allows easy access to common File menu actions 
“New”, “Open”, and “Save”.

New: creates a new robotSim project.  You can choose between an 
empty project, or one of the available environments to start with.  Be 
sure to save your current project before creating a new one.

Open: opens an existing project.  Be sure to save any changes to the 
current project before opening a different one.

Save: saves the current project.  It will save the project as the same 
name, or prompt you to choose a name if it is your first time saving 
that project.
  

Undo / Redo
The undo / redo toolbar allows easy access to the common Edit menu actions 
“Undo” and “Redo”.

Undo: reverses the last change made to the project.

Redo: applies the command that was last reversed  
using the “Undo” command.



Rotate Object: allows you to adjust the selected object’s rotation by 
clicking and dragging on the axis handles (which appear as circles for 
rotating).

Scale Object: allows you to adjust the selected object’s scale by 
clicking and dragging on the axis handles (which appear as cubes for 
scaling).
     

Simulator Control

Start / Pause: starts the simulator.  Physics calculations are 
performed, and robots can be controlled.  While the simulator is 
running, the “Start” button will become the “Pause” button, which 
pauses the simulator.  The state the simulator is in is saved when it is 

started, and once stopped, the reset action will reset the simulator to that state.  
Choosing “Start” always overwrites the reset state.

Pause: Pauses the simulator while it is running.  When the simulator is 
paused or stopped, the “Pause” button will become the “Start” button.  
Clicking “Start” while the simulator is paused will allow the simulator 
to continue running.

Stop: stops the simulator until it is started again.  Once the simulator 
is stopped, the reset button will reset the simulator to the state it was 
in before it was started.

Reset: resets the simulator to the state it was in before it was started.  
Any objects added to the simulator while it is running will be reset to 
the state they were in when they were first added.

Object / Camera Manipulation

 The object / camera manipulation toolbar allows easy switching between 
interaction modes between the mouse and the simulator.  Only one mode can 
be active at any one time.  Aside from the move camera option (which appears 
as a hand) the modes allow you to perform various transforms on objects.  The 
currently selected mode will appear darker than the rest, as the “Move Object” 
crosshairs do in the above image.

Move Camera: allows you do move the camera’s position by dragging 
on the screen.  To interact with objects, be sure to select one of the 
object manipulation modes.

Move Object: allows you to adjust the selected object’s position by 
clicking and dragging on the axis handles (which appear as arrows for 
moving).

Move Object                 Rotate Object               Scale Object



WINDOWS Objects Window

The various windows in robotSim allow you to 
interact with the simulator and its objects in many 
different ways.

The Objects Window contains all of the objects 
that can be added to robotSim (except for Robots 
and Lights).  The objects are broken up into 
categories.   
To add an object simply drag it on to the simulation 
area. Objects can be altered using the Object 
Manipulation Toolbar and the Properties Window.

Working with Objects

There are three main types of Objects in robotSim, 
objects, robots, and lights.  This section deals with 
how to work with objects generally.  To get more 
information on working with lights and robots, 
please see the sections on lights and robots.

Adding Objects

The Cube object was selected.  Once the mouse is 
dragged, the cursor changes to indicate that there 
is an object on it.  You can drop it in the Objects 
window to get rid of it, or hit the escape key.

Here the cursor is directly over the spot where we 
want to add it to the simulator.  Now we simply 
need to release the mouse button to have the Cube 
added at this location.

The cube is added once the mouse is released.

 



Robots Window

The Robots Window contains the list of available 
robots that you can use in robotSim.  As you 
upgrade and add more robot modules, this list will 
reflect the robots that you have added.  To add a 
robot to the simulator, simply click and drag it on 
to the area you would like to place it.  When you 
release the mouse, the robot will be added to the 
simulator.  For more information on robot settings, 
please see the section on the Properties Window.

Working with Robots

Robots in robotSim are special objects because 
they can receive connections and be controlled by external programs.  For more 
information on working with robots, please see the sections on the Properties 
Window and Robots Window.

Connecting to a Robot

Each robot simulated by robotSim can be connected to and controlled by separate 
programs (or separate UDP connections within a program) or computers.  Each robot 
has an IP address and port used to connect to and control it.  The control programs 
must ensure they are connected to the correct robot when controlling them.

When connecting to a robot in robotSim, first ensure that the robot has been added, 
and that the robot’s IP address and port are correct.  You can check them both in 
the Properties Window’s Robot Settings.  The IP address of the robot should be 
the IP address of the computer that is running robotSim.  The default IP address 

is 127.0.0.1, which is the 
local computer.  If you wish 
to connect to the robot over a 
network, change the IP address 
of the robot to the computer’s 
network address.  The default 
port for robots is 13000, 
incrementing for each additional 
robot added.  Change the port to 
the desired port for your robot 
before connecting.

Once the robot is set up to connect in robotSim, be sure to start the simulation.  
Now any program that can create UDP connections can connect to and control the 
robot.  To see specific APIs relating to specific robots, please refer to the sections 
specific to those robots.

NIStarterKit

 The NIStarterKit robot is a four wheeled robot controlled by two motors.  The robot 
can be controlled by setting the left and right motor velocities.  The NIStarterKit 
robot also has a sonar sensor mounted on a servo.  The servo can be moved, and 
the sonar distance data can be read.

A sample Visual Studio C++ application that controls the NIStarterKit robot can be 
found here: NIStarterKitSample

Be sure to have robotSim running with a NIStarterKit robot ready to connect.  
Double check the IP address and port to make sure they match in the main.cpp 
file, as well as in robotSim.

A brief overview of the API used in the NIStarterKitSample program is available 
here: NIStarterKitSample API Reference



Properties Window
 

The Properties Window contains all of the 
properties that can be modified for the selected 
object.  The selected object’s name is displayed 
at the top, and can be changed there as well.  The 
available properties within the Properties Window 
will change depending on what type of object is 
selected.  To expand any section of the Properties 

Window, simply click the button such as the “Transform” button.  The different 
sections of the Properties Window are as follows:

Transform

The “Transform” properties deal with an object’s position, rotation, and scale (size).

Position: the location of the 
selected object on the x, y, and z 
axes.
Rotation: the angle of the 
selected object relative to the x, y, 
and z axes.

Scale: the size of the selected 
object in the x, y, and z directions

These values are updated as an object moves, but can also be changed by typing 
new values, or using the up and down buttons on the spinboxes.
All objects in robotSim have transform properties.

Rigidbody

The “Rigidbody” properties control how an object interacts with gravity and other 
objects in robotSim.  An object must have a rigidbody if it is to be moved by the 
physics engine.

Mass: the mass of the selected 
object.  Objects with higher mass 
move less in collisions, and cause 
objects of lower mass to move 
more in collisions.

Drag: the amount an object is slowed when moved by the physics engine.  For 
example, when falling from gravity, an object with higher drag will fall slower 
(which can simulate air resistance).

Angular Drag: the amount an object is slowed when rotated by the physics 
engine.

Gravity On: whether or not this selected object is affected by gravity.  If it is 
checked, the object is affected by gravity, if unchecked it is not.

Kinematic: whether or not the selected object is affected by forces or collisions.  If 
turned on, the object will be stationary and not moved if hit by a different object, 
though the other object will still react to the collision.

Freeze Rotation: whether or not the selected object’s rotation can be affected by 
the physics engine.

Collider

The “Collider” properties control how an object reacts to collisions with other 
objects.  All colliders can be seen as green outlines if the “Physics” option is 
enabled in the “Render” menu.  

Box Collider

Box colliders are a simple box shape.



Properties Window  

Physics Behaviour: how the physics engine handles collisions with the object.  
The physics behaviour can be altered by changing the value in the combobox.   
The 6 types of physics behaviours available in robotSim are:

 None: the default physics behaviour will be applied.

 Metal: the object will behave as though it were made of metal.

 Rubber: the object will behave as though it were made of rubber.

 Wood: the object will behave as though it were made of wood.

 Bouncy: the object will behave as though it were bouncy.

 Ice: the object will behave as though it were made of ice.

Trigger: If checked, the object will not collide with anything, and instead an 
event can be hooked up to react to the object being entered by another.  This 
event handling is currently unavailable, but will be available in a future version of 
robotSim.

Size: the size of the collider.  Most colliders should be tightly fit to the object they are 
attached to.  Size can be altered in the x, y, and z directions relative to the object.

Center: the center of the collider, essentially its position on the x, y, and z axes 
relative to the object.

Sphere Collider

 Sphere colliders are a simple sphere shape.

Physics Behaviour: how the physics engine handles collisions with the object.  
The physics behaviour can be altered by changing the value in the combobox.   
The 6 types of physics behaviours available in robotSim are:

 None: the default physics behaviour will be applied.

 Metal: the object will behave as though it were made of metal.
 Rubber: the object will behave as though it were made of rubber.
 Wood: the object will behave as though it were made of wood.
 Bouncy: the object will behave as though it were bouncy.
 Ice: the object will behave as though it were made of ice.
Trigger: If checked, the object will not collide with anything, and instead an event 
can be hooked up to react to the object being entered by another.  This event 
handling is currently unavailable, but will be available in a future version of robotSim.

Radius: the radius of the collider.  Most colliders should be tightly fit to the object 
they are attached to.

Center: the center of the collider, essentially its position on the x, y, and z axes 
relative to the object.

Capsule Collider

Capsule colliders are a simple capsule shape.

Physics Behaviour: how the physics engine handles collisions with the object.  
The physics behaviour can be altered by changing the value in the combobox.   
The 6 types of physics behaviours available in robotSim are:
 None: the default physics behaviour will be applied.
 Metal: the object will behave as though it were made of metal.
 Rubber: the object will behave as though it were made of rubber.
 Wood: the object will behave as though it were made of wood.
 Bouncy: the object will behave as though it were bouncy.
 Ice: the object will behave as though it were made of ice.



Properties Window

Trigger: If checked, the object will not collide with anything, and instead an event 
can be hooked up to react to the object being entered by another.  This event 
handling is currently unavailable, but will be available in a future version of robotSim.

Radius: the radius of the collider.  Most colliders should be tightly fit to the object 
they are attached to.

Height: the height of the collider.  Most colliders should be tightly fit to the object 
they are attached to.

Direction: the direction of the collider, which can follow the x, y, or z directions 
relative to the object.  Most colliders should be tightly fit to the object they are 
attached to.

Center: the center of the collider, essentially its position on the x, y, and z axes 
relative to the object.

Mesh Collider

Mesh colliders allow collisions between objects with meshes and other objects.

Physics Behaviour: how the physics engine handles collisions with the object.  
The physics behaviour can be altered by changing the value in the combobox.   
The 6 types of physics behaviours available in robotSim are:

 None: the default physics behaviour will be applied.

 Metal: the object will behave as though it were made of metal.

 Rubber: the object will behave as though it were made of rubber.

 Wood: the object will behave as though it were made of wood.

 Bouncy: the object will behave as though it were bouncy.

 Ice: the object will behave as though it were made of ice.

Convex: If checked, the mesh collider will be forced to be convex.  Convex mesh 
colliders will collide with other convex colliders as well as non-convex meshes.  At 
this time two non-convex meshes will not collide.  The mesh must have less than 
255 polygons for this to work.

Smooth: If checked, the mesh will have smooth collisions with sphere colliders 
rolling over smooth surfaces.

Wheel Collider

Wheel colliders are used to simulate wheel friction.  Wheel colliders will not 
respond to other colliders’ physics behaviours.

Radius: the radius of the collider.  Most colliders should be tightly fit to the object 
they are attached to.

Mass: the mass of the collider.  Objects with higher mass move less in collisions, 
and cause objects of lower mass to move more in collisions.

Center: the center of the collider, essentially its position on the x, y, and z axes 
relative to the object.



Properties Window

Suspension: simulates a vehicle’s suspension system for the wheel.

 Distance: the maximum distance for the wheel suspension, relative to the  
 collider on the y-axis.

 Spring: a higher value causes the suspension to reach the target position faster.

 Damper: a higher value causes the suspension to reach the target position  
 more slowly.

 Target Pos: the target position that the suspension tries to reach.  A fully  
 extended suspension is 0, and a fully compressed suspension is 1.

Forward Friction: friction properties in the forward direction.  Wheels follow a 
friction curve, whose points can be controlled with the extremum and asymptote 
values.

 Extremum: the peak of the friction curve.  The slip is the x-axis, the value is  
 the y-axis (force).

 Asymptote: the point after the extremum where the curve levels off.  The slip  
 is the x-axis, the value is the y-axis (force).

 Stiffness: the stiffness of the friction.  This value is used as a multiplier with  
 the etremum and asymptote values.  A stiffness of 0 will remove all friction  
 from the wheel.

Sideways Friction: friction properties in the sideways direction.  Wheels follow a 
friction curve, whose points can be controlled with the extremum and asymptote 
values. 

 Extremum: the peak of the friction curve.  The slip is the x-axis, the value is  
 the y-axis (force).

 Asymptote: the point after the extremum where the curve levels off.  The slip  
 is the x-axis, the value is the y-axis (force).

 Stiffness: the stiffness of the friction.  This value is used as a multiplier with  
 the etremum and asymptote values.  A stiffness of 0 will remove all friction  
 from the wheel.

Material / Texture

The Material / Texture section of the Properties 
Window allows you to change the appearance of 
your objects.  At this time only the colour of each 
material on an object can be changed.

In this example we have a coffee table that has two different materials on it.  We can 
click on the “Color” box to give us a color choosing dialog.  The Color dialog has 3 
different ways to choose a color, show above. If we change the “CoffeeTable-maple” 
color, it is reflected in the part of the object that had that material applied to it.

If we change the “CoffeeTable-chrome” color, it is reflected in the part of the object 
that had that material applied to it:

Color Wheel         Color Spectrum    RGB Sliders



Properties Window 

Light Settings

There are 3 types of lights in robotSim, Directional, Point, and Spot.  Their settings 
vary slightly in the Properties Window.

Type: the type of light can be changed with the combobox (choices are Directional, 
Point, or Spot).

Color: the color of the light emitted.

Attenuate: check if you want the light to attenuate over distance.  Does not affect 
directional lights.

Shadows: the type of shadows cast by the light (choices are None, Hard, and Soft).  
Using shadows may reduce performance, soft shadows will degrade performance 
more than hard shadows.

Intensity: how bright the light is.  A high intensity can wash out the light color.

Range: the distance that the light can reach.

Spot Angle (Spot lights only): the angle of the spot light.

Robot Settings

The “Robot Settings” section of the Properties Window allows you to change 
settings for the robots in the simulator.  The current settings that can be changed 
are the Port and IP address that are used to control the robot from an external 
program (such as LabVIEW or a C++ application).

Port: the port that the robot is using.  Use this port to connect to the sim from 
another application to control the robot.

Address: the address of the computer running the simulator.  If you are connecting 
to the sim from a program on the same computer, the default localhost address 
(127.0.0.1) will work.  If you are connecting to the simulator from a different 
computer over a network, you will need to enter the IP address of the computer 
running the simulator here.



Explorer Window
 

The Explorer Window shows all of the objects 
that are currently in the simulator.  If an object 
has child objects inside it, they will be displayed 
underneath (if the object is expanded in the 
Explorer Window) or hidden (if the object is 
collapsed as they are in the image above).

When you click on an object in the Explorer 
Window it will be selected in the simulator.  If 
you click on an object in the simulator, it will be 
highlighted in the Explorer Window.

Items can be reordered by dragging them in the 
Explorer Window.

You can reparent items by dragging them in the Explorer Window.  Just click and 
hold while dragging to the desired parent of the object you have selected.


